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Financial Year-End 2022/2023 
 
  
 

A. Overview of Financial Year end 2022/2023 

 

The annual accounts must be prepared using the latest version of the FSSU chart of accounts 
(August 2023) which is available here on our website. These codes will be effective for 
the Year ended August 2023 and it is important to compare the current list of nominal 
codes in your school’s accounts package with this latest chart of accounts to ensure that 
both are in alignment.  
 
There will be minimal changes to the chart of accounts for next year 2023/2024.  
The new codes shown below are relating to the Primary Free Schoolbook Grant and will 
not be relevant to the Post Primary sector.  
 
Please ensure that these specific codes are not used for a different income or cost type. 

 

• 3151      Primary Free Schoolbook Grant  

• 3152      Primary Free Schoolbook Admin Grant  

• 4731      Primary Free Schoolbook Grant Expense  

• 4113      Primary Free Schoolbook Admin Salaries Expense 
 
 

B. COVID Grants 
 

The accounting for COVID Grants and the related expenditure continued to be a feature 

of the accounts function for the financial year and the Department of Education (DE) have 

requested that any unspent COVID Capitation for Cleaning and PPE grant for the 2022/ 

2023 school year should be repaid to the DE’s bank account by electronic funds transfer 

by 30th September 2023.  

 

To arrive at the correct repayment figure, it is vital that schools have recorded correctly 

all COVID cleaning & PPE costs paid from all the COVID grants received under the advised 

COVID code and that the accuracy of these postings is checked thoroughly. Where the 

Department report is used and relied upon to verify the repayment figure, it is crucial to 

check that every COVID transaction is correctly allocated to that relevant COVID 

department number in Sage 50. Further guidance on the calculation of this COVID 

repayment is available in Appendix 1. 
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C. Summary of key deadlines 

  
The school should aim to supply all financial information to their external accountant/auditor 
for the school year ending 31st August 2023 by 30th September 2023. Other key deadline 
dates to be aware of are: 

 

 

Sage 50cloud Upgrade & Version 29.0 

 

Most of the Voluntary Secondary Schools have upgraded and are availing of the remote 

data access and Bank feeds features available with the software. The FSSU strongly advise 

the setting up of remote data access for your Accountant as it will enhance the efficiency of 

the school accounts preparation process at the end of the financial year. 

 

It is advisable to check the version of Sage under Help / About and ensure that it is the 

latest Version 29.0. In addition, the variant should read Sage 50cloud Accounts.   

 

If you are on Sage 50 Accounts and have not upgraded please complete the  

purchasing form as a matter of urgency and email it to the addresses noted on the form.  

 

There is a webinar planned for later this month specifically for schools that have not yet 

upgraded. It will give an outline of the simple steps in upgrading and will note that there 

are no significant changes to the operation of the software. The main benefits of upgrading 

are the new features, in particular remote data access and bank feeds, which will enhance 

and speed up the Accounts preparation process. We will provide support and training for 

these new features throughout the year as required. 

Year-end procedure in Sage 50 should be processed by early November 2023 

To run the BOM reports for the new year which includes the budget for 2023/2024 and 
prior year figures, the Financial Year End must be processed in Sage 50.  
 
 

Date Action  

  30th September  The board provides all financial information to the external accountant 

for the school year 31st August.  

  30th November  The draft annual accounts are returned by the accountant.  

  31st December  Accounts are reviewed and approved by the board and signed by the 

chairperson and one other board member.  

  28th February  
Accountant submits the accounts to the FSSU and uploads a pdf copy of 

the approved annual accounts. 

https://www.fssu.ie/app/uploads/2021/01/Sage-50Cloud-Purchasing-Form-19.04.22_rev.pdf
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We would suggest that the latest date for running the Year end in Sage should be the first 
week in November 2023 to ensure that the Board of Management receive all the 
definitive reports for the new financial year. There is a webinar planned around that time 
which will focus on working with the school accountant to finalise the Year End figures in 
Sage 50. 

 

D. Preparation for Year End 2022 / 2023 

 It is important that school’s chart of accounts is in alignment to the revised FSSU Chart of 
accounts so therefore it is advised to compare the current list of nominal codes in your 
schools Sage 50 with the revised FSSU chart of accounts to check for any inconsistencies.  
 
A revised FSSU Chart of accounts is available here on our website. 

 
This will facilitate the inputting of the accounts into the FSSU Online accounts submission 
system by your external accountant/auditor and reporting of financial information to the 
Department and to the Charities Regulator. 
 

 

Before running the year end 2022/2023: Done 

1. Post all day-to-day transactions for the year. This ensures that your 

management reports and year end postings are accurate. Ideally any audit 

adjustments from the accountants should be posted to the income and 

expenditure codes within a reasonable time frame. 

 

2. Ensure you have bank statements for all school bank accounts covering the 

period 1st September 2022 to 31st August 2023 and ensure all bank accounts 

are reconciled up to 31st August 2023.  

 

3. Review the bank reconciliation report as follows: 

a. Review the list of outstanding payments and receipts on the bank 

reconciliation to ensure they are accurate.  

b. Any duplicate entries should be corrected.  

c. Any outstanding payments/receipts more than six-months-old should be 

investigated. 

 

4. Ensure that the petty cash and credit card transactions are recorded for the 

year and that the balances in the petty cash and credit card account are 

correctly stated at the end of the year. 

 

5. Ensure that the balance in the Cash Control Account equates to the amount of 

cash and cheques held in the safe on 31st August 2023. 

 

6. Ensure that the balance in the online payment solution clearing account (code 

1870) equates to the amount of money owed from the online payments 

company at the 31st of August 2023. 

 

https://www.fssu.ie/post-primary/topics/sage-50-accounts/chart-of-accounts/chart-of-accounts/
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7. Payroll records: Print individual employee payroll records for the period 1st 

September 2022 to 31st August 2023, print copy of the payroll summary for 

the 2022 year and have a backup of the payroll saved to a memory stick for 

2022 and up to 31st August 2023  

 

8. The PAYE/PRSI/USC/LPT control account (nominal code 2250) should equate to 

the PAYE/PRSI/USC/LPT that is owed to Revenue at 31st of August 2023. 

(Where payroll journals are utilised) 

 

9. The net wages control account (code 2200) should be zero or any balance 

explained. 

 

10. Other wage related control account balances (e.g., Union Fees, Single Public 

Pension Scheme, ASC) should equate to amounts owed at 31st August 2023 (if 

recording payroll using the payroll journal). 

 

11. VAT: Review ROS to ensure all VAT returns are filed. Remember you must file 

VAT returns even if liability is Nil. 

The VAT control account (nominal code 2260) should equate to the VAT that is 

owed to Revenue at 31st of August 2023 (if using VAT journals) 

 

12. RCT: Ensure all deductions made from Subcontractors for RCT purposes have 

been returned to Revenue  

 

13. Parents Association: Ensure all financial documentation is made available to the 

school’s external accountant/auditor for inclusion in the annual financial accounts 

of the school.  

 

14. Complete a manual list of creditors on 31st August 2023 (money owed by the 

school). If using the purchase ledger print an outstanding creditors list at 31st 

August 2023 and agree balances per the report to the supplier’s 

statement/unpaid invoices.  

 

15. Complete a manual list of debtors & prepayments at 31st August 2023 (money 

owed to the school). If using the sales ledger print an outstanding debtors list at 

31st August 2023 and match the balances to statements sent to customers. 

 

16. Income received in the current year (2022/2023), for the next school year 

(2023/2024) should be shown as income received in advance on the balance 

sheet code 2105. Use the department function to analyse the various types 

within the nominal account. This will facilitate the running of a nominal activity 

report by department for code 2105 at 31.08.2023 for audit purposes.  

 

17. Alternatively, complete a manual list of income/grants received by the school in 

the year 2022/2023 that relate to 2023/2024 school year e.g., book grant, 

transition year charges, school administration charges, voluntary contribution.  

 

18. Review the grants for the year to ensure that all grants received for the next 

academic year have been included in the accounts as ‘Grants Received in 

Advance (nominal codes 2150-2152).  
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19. Review the income and expenditure for ring fenced grants/income and carry 

any unspent amounts forward as unspent grants/income. See Appendix 2 for 

further information. 

 

20. Ensure the balances of COVID grants unspent is correctly accounted for.  

See Appendix 1 for further information. 

 

21. Run a Nominal Activity Report and review the posting of transactions, to ensure 

they are accounted for correctly. 

 

22. Year-end Adjustments for creditors, debtors and income received in advance 

should be posted to SAGE 50 at 31.08.2023 before running year end if 

possible. 

 

 

E.  Print out the recommended Financial Reports for the year end 

Reports To Run Reports 

 
Trial Balance 

 
Nominal codes > Trial Balance 
Nominal codes > Reports > Trial Balance 
 

 
Balance Sheet 

 
Nominal codes > Reports > My nominal code reports >BOM Balance Sheet 
 

 
Profit & Loss 

 
Nominal codes > Reports > My nominal code reports >BOM Income & 
Expenditure Account 

 
Nominal Activity  

 
Nominal codes > Reports> Nominal Activity 
 

Unreconciled 
Payments/Receipts 

 
Bank accounts > Reports > Unreconciled transactions 
 

Aged creditors 
report 

(only for schools 
using the Supplier 

module) 

 
Suppliers > Reports > Aged creditors > Aged creditors summary  
Suppliers > Reports > Aged creditors > Aged creditors detailed 
Suppliers > Reports > Activity > supplier activity detailed 
 

 
Aged debtors report 

(only for schools 
using the Customer 

module) 

 
Customers > Reports > Aged debtors > Aged debtors analysis summary  
Customers > Reports > Aged debtors > Aged debtors analysis detailed 
Customers > Reports > Activity > customer activity detailed 

 
Department report 

for code 2105 

 
Department > Reports > Nominal Analysis > Nominal Department analysis 
detailed > nominal code 2105 and default on the dept numbers 
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Department report  
for COVID 
transactions 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Departments > Reports > Nominal Analysis > Nominal Department 
analysis detailed > department no 1 is COVID in this example. Let nominal 
code default so it will give every code where dept 1 is assigned. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NB: If COVID transactions were not assigned the relevant dept number then 
they will not appear in this report.  
 

 

 

F. System Back-Up 
 
Take A Minimum of TWO Backups and save to two separate locations (external hard-
drive/Network). Name it ‘Before Year End’- it is essential to back up the data before 
running the year end, as this is the only way to go back to a pre-year position.  
 
Please see Section G for running your year end in Sage 50. Further information or 
clarification on any of the issues raised in this Guideline can be obtained from the FSSU.  
 

G. Processing the Year End in Sage 50 

 

Schools should liaise with their external accountants/auditors and request them to review 

the school accounts as soon as possible and to return a draft Trial Balance which will 



7 

 

include any changes to the income and expenditure for the year. The necessary audit 

adjustments can be inputted into Sage 50 before processing year end and the Income 

and Expenditure figures appearing in the archived accounts will substantially agree to 

the signed Financial Statements at 31.8.2023. If there are further changes after 

processing the year end, the adjustments can be made to the Balance Sheet codes dated 

31.08.2023. 

Sage 50 has a soft year end, and this means you can post into your new financial year 
before running the Year End option. It's important to make sure the transaction date is 
correct. A message advises that the date is outside the current financial year, click Ok or 
Yes. The following reports can be run for the new financial year until you run the year 
end - Transactional Profit and Loss, Transactional Balance sheets and Transactional Trial 
Balances reports. Please note these reports are for internal/office use and should not be 
used for Board of Management (“BOM”) meetings.  

To run the BOM reports for the new year which includes the budget for 2023/2024 and 
prior year figures, the Financial Year End must be run in Sage 50. Therefore, this year-end 
process cannot be put off for audit adjustments for too long into the new Financial Year. 
We recommend that the latest date for running the Year end in Sage should be the first 
week in November 2023 to ensure that the Board of Management receive all the 
definitive reports for the new financial year. 

Where Sage is setup on a network, the year-end routine should be run on the computer 
that holds the data. If you have a large dataset, it may take a little time to run the 
process. This time will be reduced if you run the routine on the computer that holds your 
accounts data. 

1. Running the Financial Year End 

➢ Change the program date-change the program date to be the last day of the 
financial year. e.g., 31st August 2023. 

➢ Take TWO backups labelled ‘Before Year End’- it is essential to back up the data 
before running the year end, as this is the only way to go back to a pre-year position. 
It is advisable to take two backups as a precaution against loss or damage of the 
backup media. 

➢ To run the Year End, select Tools >Period End >Year End.  
This will display the year end window and complete all the steps. 

➢ Archive Data – select the option to archive data. This will enable you to view old 
data without having to restore old backups.  

➢ Prevent new transactions from being entered before this date – you should  
leave this option unticked if you have not yet posted your audit adjustments. 

➢ Check the details shown at the bottom of the Year End window are correct 
before selecting the Run Year End option.  

➢ Click YES if the Year End dates are correct.  
A year end progress screen will appear. Once complete you will be asked if 
you would like to print the Year End journal. Click ok. 

➢ A final message appears that the financial year end has been completed, click OK. 



8 

 

2. Check Data After Running the Year End  

Run a Brought Forward trial balance. Select Modules >Nominal codes >Trial 
Balance for the period select Brought Forward 
 

•  Make sure there are no income and expenditure codes on this report 

•  Next, Check your data again. File>Maintenance > check Data 

•  Finally take another backup of the data and label it ‘After Year End’ 

➢ Do NOT clear the audit trail. However, if there are more than two years accounts 
data on Sage 50 and if Sage processing appears to be slowing down then clearing 
the audit trail should be considered. Please refer to our Sage 50 section of the website 
for details on this process. 

 
Full details on running the year end are in ‘FSSU SAGE Accounts Manual - Section 8’  

3. The school Budget for 2023/2024 should now be imported into Sage 50.   

There is a new excel sheet included in the Budget Template 2023/2024 called “Sage 
50 Import” which provides a summary of the nominal codes and the total budget figures 
for the year. The details in Column A, B & D of this sheet can be copied into a template 
available in Sage 50, and this will enable the budget data to be imported into Sage 
50.  

See our website here for guidance along with a demo video on the process.  
Please ensure that your budget import template has the same nominal codes as 
exist in your Sage 50 accounts and that a backup is taken before importing the 
information.  

4. Audit adjustments 

Once the year end is run, any audit adjustments for the 2022/2023 Accounts should 
be dated 31.08.2023 and should only be made to Balance Sheet codes with Income 
and Expenditure adjustments recorded in the Revenue Reserves code 2710 Surplus 
Brought Forward. 

5. Prior year comparatives 

For those schools who want their Income and Expenditure Account showing the prior 
year, year to date comparatives instead of the full prior year, this optional report 
along with the instructions on how to copy into Sage 50 are available on the Getting 
started in Sage 50 Cloud section of our website. 

H. Sage 50 Training 

We are running some live webinar training sessions from September - November to 
supplement and support this Guideline by providing guidance on preparing for and 
finalising the year end in Sage 50. 

https://www.fssu.ie/post-primary/topics/sage-50-accounts/manual-guides/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/training/training-videos/importing-the-budget/
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There are two webinars planned for new Accounts personnel, the first for those who are 
updating the August Year end accounts for the first time and another which will focus 
on explaining the chart of accounts & reporting from Sage 50. 

There is also webinar training planned for using The Suppliers Module in Sage 50 with 
a view to encouraging schools to move to using the Suppliers ledger for recording 
purchase invoices in Sage 50.  

All these planned webinars will build on the supply of FSSU demand videos for Sage 
50 which are available on our website. In addition to the Sage videos there is a  
new section on our website which has a variety of training video resources for new 
accounts personnel training which will enhance their knowledge of school accounts 
preparation. 

The FSSU will continue to provide ongoing support and training to ensure Schools are 
using the software to its maximum potential and will continue to assist schools with the 
new features in Sage 50cloud Accounts. In particularly we encourage the use of bank 
feeds as this will enhance the efficiency and timeliness of the accounts function while the 
remote data access allows for authoriser users from school management to have real 
time access to the school financial data.  

Tel: 01-269 0677  

info@fssu.ie  

 

12th September 2023 

 
 

 

 

 

 

 

 

 

 

 

 

https://www.fssu.ie/post-primary/training/training-resources-for-new-accounts-personnel/
mailto:info@fssu.ie
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Appendix 1 

Accounting for Unspent COVID Grants  
 

The portion of unspent COVID Capitation for Cleaning & PPE grant must be accounted 
for at the end of the year using CODE 2186 in the chart of accounts.  
 
To account for the unspent grants, follow the steps below: 
 

▪ Step 1: Calculate the amount of the grant unspent at the 31.08.2023  
(Income Less Expenditure) 
 

▪ Step 2: Post a journal dated 31.08.2023 to transfer the unspent element to the 
balance sheet.  
 

▪ Note: As the unspent portion of the COVID grant at the 31.08.2023 is to be returned 
to the Department by the 30.09.2023 there is no need to journal the grants back into 
the Income & Expenditure code on the 01.09.2023 
 

Click here for a worksheet to assist with the accounting of unspent COVID grants. 
 

 

 

 

 

 

 

 

 
 
 
 
 

Grant 

 
 

 Step 1 Step 2 

Income 
 

Expenditure 
 

Balance of 
Grant at 

31.08.2023 
 

Journal Unspent amount at 
31.08.2023 

Nominal 
Code 

Amount Nominal 
Code 

Amount Amount Dr Code 
 

Cr Code Dep. 

 
COVID 
Capitation 
PPE Grant 

 
3288 

 
€29,000 

 
5806 

 
€18,000 

 
€11,000 

 
3288 

 
2186 

 
COVID 

https://www.fssu.ie/app/uploads/2023/09/Covid-Grant-Reconciliation-Template-for-the-period-ending-Aug-2023_rev.xlsx
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Appendix 2 
 

Accounting for Unspent Grants/Income 

 
Some grants/incomes are received for a specific purpose, for example the ICT grant 
and the supervision & substitution grant. These are known as ringfenced grants.  
The unspent portion of these grants should be deferred until it is spent by the school. 
 
The portion of unspent ringfenced grant balances must be accounted for at the end of the 
year using the relevant balance sheet code/s (2160-2180) in the chart of accounts.  
 
The following grants are examples of ringfenced grants. 
 

➢ Book Grant, Supervision and Substitution Grant, ICT Grant, Non-teacher Pay 
Grant, Bus Escort Grant, Schools Meal Grant etc. 
 

To account for the unspent grants, follow the steps below: 
 

▪ Step 1: Calculate the amount of the grant unspent at the 31.08.2023 (Income Less 
Expenditure) 

 

▪ Step 2: Post a journal dated 31.08.2023 to transfer the unspent element to the 
balance sheet.  

 

▪ Step 3: Post a journal dated 01.09.2023 to transfer the unspent element back to the 
Income & Expenditure report for use in the 31.08.2024 year. 
 

 Click here for a worksheet to assist with the accounting of unspent grants. 
 

  

https://www.fssu.ie/app/uploads/2023/09/VSS-calculation-of-unspent-grants-template.xlsx
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Table 1: Example of Accounting for Unspent Grant 

 

 

 

 

 
 
 
 
 

Grant 

Step 1 Step 1 Step 1 Step 2 Step 3 

Income 
 

Expenditure 
 

Balance of 
Grant at 

31.08.2023 
 

Journal Unspent 
amount at 
31.08.2023 

 

Journal Unspent 
amount at 
01.09.2023 

 

Nominal 
Code 

Amount Nominal 
Code 

Amount Amount Dr 
Code 
 

Cr 
Code 

Dr 
Code 

Cr 
Code 

Book Grant 3150 €9,600 4730 €8,900 €700 3150 2160 2160 3150 

Supervision & 
Substitution Grant 

3240 €5,130 4150 €4,200 €930 3240 2170 2170 3240 

School Library Books 
Capital Grant 

3155 €15,000 4641 €1,000 €14,000 3155 2161 2161 3155 

Bus Escort Grant 3294  4196   3294 2171 2171 3294 

DSP School Meals 3296  4912   3296 2171 2171 3296 

Digital Strategy/ICT 
Grant (Non-Capital) 

3230  €27,500 4410  €17,500 €10,000 3230  2165 2165 3230 

Digital Strategy/ICT 
Grant (Non-Capital) 

3921 €27,500 1461 €17,500 €10,000 3921 2165 2165 3921 

Digital Divide Grant 
(Non-Capital) 

3230  €20,000 4410  €17,500 €2,500 3230  2179 2179 3230 

Digital Divide Grant 
(Capital) 

3921 €20,000 1461 €17,500 €2,500 3921 2179 2179 3921 
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Deireadh na Bliana Airgeadais 2022/2023 
 
  
 

A. Forléargas ar Dheireadh na Bliana Airgeadais 2022/2023 

 
Ní mór na cuntais bhliantúla a ullmhú leis an leagan is déanaí de cairt chuntas an FSSU 

(Lúnasa 2023) atá ar fáil anseo ar ár suíomh idirlín. Beidh na cóid seo i bhfeidhm don 

bhliain dar críoch Lúnasa 2023 agus tá sé tábhachtach liosta reatha na gcód ainmniúil i 

bpacáiste cuntas do scoile a chur i gcomparáid le cairt seo na gcuntas athbhreithnithe is 

déanaí lena chinntiú go dtagann siad lena chéile.  

 

Beidh athruithe fíorbheaga ann do chart chuntas na bliana seo chugainn 2023/2024. 

Baineann na cóid a léirítear thíos leis an Deontas Leabhar Bunscoile in Aisce agus ní 

bhainfidh siad leis an earnáil Iarbhunscolaíochta.  

 

Cinntigh nach n-úsáidtear na cóid sonracha seo le haghaidh cineál eile ioncaim nó costais 

in Sage 50.  

 

• 3151     Deontais Leabhar Bunscoile in Aisce  

• 3152     Deontas Riaracháin Leabhair Shaor in Aisce Bunscoile  

• 4731     Costas Deontais Leabhar Bunscoile in Aisce  

• 4113     Costas Tuarastail Riaracháin Leabhar Bunscoile in Aice 

 

 

B. Deontais COVID 
 

Bhí cuntasaíocht do Dheontais COVID agus don chaiteachas gaolmhar fós mar ghné 

d’fheidhm na gcuntas don bhliain airgeadais agus d’iarr an Roinn Oideachais (RO) go 

n-aisíocfaí le cuntas bainc na RO trí ríomhaistriú airgid faoin 30 Meán Fómhair 2023 aon 

deontais neamhchaite a bhain le Caipitíocht COVID-2022 do ghlantachán agus do 

threalamh cosanta pearsanta don scoilbhliain 2023.  

 

Chun teacht ar fhigiúr ceart na n-aisíocaíochtaí, tá sé ríthábhachtach go mbeadh na 

costais uile glantacháin agus trealamh cosanta pearsanta COVID a íocadh ó na deontais 

COVID uile a fuarthas faoin gcód ceart COVID taifeadta i gceart ag na scoileanna agus 

go ndéanfaí cruinneas na bpostálacha sin a sheiceáil go críochnúil. Sa chás go n-

úsáidtear agus go mbítear ag brath ar thuarascáil na Roinne chun an figiúr aisíocaíochta 

a fhíorú, tá sé ríthábhachtach seiceáil a dhéanamh go ndearnadh gach idirbheart COVID 

Treoirlíne Airgeadais 

2023/2024 
Meánscoileanna Deonacha 

05 
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a leithdháileadh i gceart ar uimhir ábhartha COVID na Roinne i Sage 50. Tá tuilleadh 

treorach faoi ríomh na haisíocaíochta COVID seo ar fáil in Aguisín 1. 

 

C. Achoimre ar na príomh-spriocdhátaí 

  

Ba cheart go mbeadh sé mar aidhm ag an scoil an fhaisnéis airgeadais uile maidir leis 

an scoilbhliain dar críoch an 31 Lúnasa 2023 a sholáthar dá cuntasóir/hiniúchóir 

seachtrach faoin 30 Meán Fómhair 2023. Is iad na príomh-spriocdhátaí eile nach mór 

a bheith ar an eolas fúthu ná: 

 

 

Uasghrádú Sage 50cloud & Leagan 29.0 

 

Tá an chuid is mó d’Iar-bhunscoileanna Deonacha tar éis uasghrádú a dhéanamh agus 

tá leas á bhaint acu as rochtain ó chian ar shonraí agus ar na gnéithe a bhaineann le 

fothaí Bainc atá ar fáil leis an mbogearra. Molann an FSSU go láidir cianrochtain sonraí 

a chur ar bun do do Chuntasóir mar gheall go gcuirfidh sé le héifeachtúlacht an phróisis 

ullmhúcháin cuntas scoile ag deireadh na bliana airgeadais. 

 

Moltar an leagan Sage a sheiceáil faoi Help / About agus a chinntiú gurb é an leagan 

is déanaí 29.0. In éineacht leis sin, ba chóir gurb é Sage 50cloud Accounts an athróg.   

 

Má tá tú ar Sage 50 Accounts agus mura ndearna tú uasghrádú, comhlánaigh an  

fhoirm cheannacháin mar ábhar práinne agus seol tríd an ríomhphost í chuig na 

seoltaí atá luaite ar an bhfoirm.  

 

Tá seimineár gréasáin sceidealta níos déanaí an mhí seo go sonrach do scoileanna nach 

ndearna uasghrádú fós. Tabharfar imlíne ann ar na céimeanna simplí a bhaineann le 

huasghrádú agus tabharfar faoi deara nach bhfuil aon athruithe suntasacha d’oibriú an 

bhogearra. Is iad na príomhbhuntáistí a bhaineann le huasghrádú ná na gnéithe nua, go 

háirithe an chianrochtain ar shonraí agus na fothaí bainc, rud a fheabhsóidh agus 

Dáta Gníomh  

   30 Meán Fómhair Cuireann an bord an fhaisnéis uile airgeadais ar fáil don chuntasóir 

seachtrach don scoilbhliain faoin 31 Lúnasa  

 30 Samhain Cuireann cuntasóir isteach na dréachtchuntais bhliantúla  

 31 Nollaig Déanann an bord na cuntais a athbhreithniú agus a cheadú agus 

síníonn an Cathaoirleach iad, mar aon le ball amháin eile den bhord  

 28 Feabhra 
Cuireann an cuntasóir na cuntais isteach chuig an FSSU agus 

uaslódálann cóip PDF de na cuntais bhliantúla cheadaithe  

https://www.fssu.ie/app/uploads/2021/01/Sage-50Cloud-Purchasing-Form-19.04.22_rev.pdf
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chuirfidh luas faoin bpróiseas ullmhúcháin Cuntas. Cuirfimid tacaíocht agus oiliúint ar fáil 

i dtaca leis na gnéithe nua seo i rith na bliana de réir mar a iarrtar. 

 

Ba chóir nós imeachta deireadh bliana i Sage 50 a phróiseáil faoi thús mhí na 

Samhna 2023 

Chun tuarascálacha an Bhoird Bhainistíochta a rith i gcomhair na bliana nua, lena n-áirítear 
an buiséad le haghaidh 2023/2024 agus figiúir na bliana roimhe sin, ní mór Deireadh na 
Bliana Airgeadais a phróiseáil in Sage 50. Mholfaimis gurb é an dáta is déanaí chun 
Deireadh na Bliana a reáchtáil i Sage an chéad tseachtain i mí na Samhna 2023 chun a 
chinntiú go bhfaighidh an Bord Bainistíochta na tuairiscí cinntitheacha go léir don bhliain 
airgeadais nua. Tá seimineár gréasáin beartaithe um an am sin a dhíreoidh ar obair a 
dhéanamh le cuntasóir na scoile chun na figiúirí Deireadh Bliana a thabhairt chun críche 
in Sage 50. 

 

D. Ullmhú do Dheireadh na Bliana 2022/2023 

Is tábhachtach go mbeadh Cairt Cuntas na scoile i gcomhréir le Cairt Cuntas 

athbhreithnithe FSSU; mar sin, moltar an liosta reatha cód ainmniúil in Sage 50 do scoile 

a chur i gcomparáid le Cairt Cuntas athbhreithnithe FSSU chun a sheiceáil an ann d’aon 

neamhréireachtaí.  

 

Tá cóip de Chairt Cuntas athbhreithnithe FSSU ar fáil anseo ar ár láithreán gréasáin. 

 

Éascóidh sin obair do chuntasóra/d’iniúchóra seachtraigh maidir le iontráil na gcuntas i 

gcóras seolta cuntas ar líne FSSU, agus tuairisciú faisnéis airgeadais don Roinn agus don 

Rialálaí Carthanas. 
 

Sula ndéantar tuarascálacha deireadh bliana 2022/2023 a rith: Déanta 

1. Déan na hidirbhearta uile ó lá go lá i gcomhair na bliana a bhreacadh síos. 

Ar an mbealach sin, is féidir a chinntiú go bhfuil do chuid tuarascálacha 

bainistíochta agus breacadh dheireadh na bliana cruinn. B’fhearr aon 

choigeartuithe ó na cuntasóirí a bhreacadh leis na cóid Ioncaim agus 

chaiteachais laistigh de thréimhse ama réasúnta. 

 

2. Cinntigh go bhfuil ráitis bhainc agat maidir le cuntais uile na scoile, lena 

gcumhdaítear an tréimhse ón 1 Meán Fómhair 1 2022 go dtí an 31 Lúnasa 

2023 agus cinntigh freisin go bhfuil na cuntais bhainc go léir réitithe suas go 

dtí an 31 Lúnasa 2023.  

 

https://www.fssu.ie/post-primary/topics/sage-50-accounts/chart-of-accounts/chart-of-accounts/
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3. Déan athbhreithniú ar an tuarascáil imréitigh bhainc mar seo a leanas: 

a. Déan athbhreithniú ar liosta na n-íocaíochtaí amuigh agus na bhfáltas 

ar an ráiteas imréitigh bainc lena chinntiú go bhfuil siad cruinn ceart.  

b. Ba cheart gach iontráil dhúblach a cheartú.  

c. Ba cheart gach íocaíocht/fáltas amuigh atá níos sine ná sé mhí d’aois 

a iniúchadh. 

 

4. Cinntigh go ndéantar na hidirbhearta mionairgid agus cárta creidmheasa a 

bhreacadh síos i gcomhair na bliana agus go luaitear na hiarmhéideanna sa 

chuntas mionairgid agus carta creidmheasa i gceart ag deireadh na bliana. 

 

5. Cinntigh go bhfuil an t-iarmhéid sa Chuntas Rialaithe Airgid i gcomhréir le 

méid an airgid thirim agus na seiceanna atá á gcoimeád sa taisceadán ar 

an 31 Lúnasa 2023. 

 

6. Cinntigh go bhfuil an t-iarmhéid sa chuntas imréitigh íocaíochtaí ar líne (cód 

1870) i gcomhréir leis an méid airgid atá dlite ón gcuideachta íocaíochtaí ar 

líne amhail ar an 31 Lúnasa 2023. 

 

7. Taifid phárolla: Déan taifid phárolla a phriontáil do na fostaithe faoi leith 

don tréimhse ón 1 Meán Fómhair 2022 go dtí an 31 Lúnasa 2023, déan cóip 

den achoimre párolla don bhliain 2022 a phriontáil agus bíodh cóip chúltaca 

den phárolla sábháilte agat ar mhéaróg chuimhne le haghaidh 2022 agus 

suas go dtí an 31 Lúnasa 2023  

 

8. Ba cheart gurbh ionann an méid sa chuntas rialúcháin 

ÍMAT/ÁSPC/MSU/CMÁ (cód ainmniúil 2250) agus an méid 

ÍMAT/ÁSPC/MSU/CMÁ atá dlite do na Coimisinéirí Ioncaim amhail ar an 31 

Lúnasa 2023. (Sa chás go mbaintear úsáid as irisí párolla) 

 

9. Ba chóir gurbh ionann an cuntas rialúcháin glanphá (cód 2200) agus náid, nó 

más ann d’iarmhéid, ba chóir é a mhíniú. 

 

10. Aon iarmhéideanna eile i gcuntais rialúcháin a bhaineann le pá (m.sh. táillí 

ceardchumainn, Scéim Pinsin Poiblí Aonair, Ranníocaíocht Aoisliúntais Bhreise), 

ba cheart gurbh ionann iad agus na méideanna dlite amhail ar an 31 

Lúnasa 2023 (más rud é go bhfuil an párolla á thaifeadadh tríd an leabhar 

cúnta párolla). 

 

11. CBL: Caith súil siar ar ROS lena chinntiú go ndearnadh na tuairisceáin CBL go 

léir a chomhdú. Cuimhnigh nach mór duit tuairisceáin CBL a chomhdú fiú 

amháin más ionann do dhliteanas agus toradh nialasach. 

Ba cheart gurbh ionann an méid sa chuntas rialúcháin CBL (cód ainmniúil 

2260) agus an méid CBL atá dlite do na Coimisinéirí Ioncaim amhail ar an 

31 Lúnasa 2023 (má táthar ag úsáid irisí CBL) 

 

12. RCT: Áirithigh go ndearnadh an hasbhaintí uile a baineadh ó 

Fhochonraitheoirí chun críocha RCT a thuairisciú chuig na Coimisinéirí Ioncaim  
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13. Cumann na dTuismitheoirí: Cinntigh go gcuirtear an doiciméadúchán 

airgeadais uile ar fáil do chuntasóir/iniúchóir seachtrach na scoile lena 

chuimsiú i gcuntais airgeadais bhliantúla na scoile.  

 

14. Déan liosta creidiúnaithe de láimh ar an 31 Lúnasa 2023 (airgead atá dlite 

ag an scoil). Má tá úsáid á baint as mórleabhar ceannacháin, priontáil liosta 

creidiúnaithe amhail ar an 31 Lúnasa 2023 agus réitigh le chéile na 

hiarmhéideanna de réir na tuarascála agus ráiteas/sonraic neamhíoctha an 

tsoláthraí.  

 

15. Cuir liosta féichiúnaithe & réamhíocaíochtaí i gcrích de láimh amhail an 31ú 

Lúnasa 2023 (airgead atá dlite don scoil). Má tá úsáid á baint as 

mórleabhar ceannacháin, priontáil liosta na bhféichiúnaithe amuigh amhail ar 

an 31 Lúnasa 2023 agus bí cinnte go dtagann na hiarmhéideanna leis na 

ráitis a sheoltar chuig custaiméirí. 

 

16. Aon ioncam faighte sa bhliain reatha (2022/2023), atá ceaptha don bhliain 

dar gcionn (2023/2024), ba chóir é a thaispeáint ar an gclár comhardaithe 

cód 2105 mar ioncam scoile faighte roimh ré. Bain úsáid as feidhm na roinne 

chun anailís a dhéanamh ar na cineálacha éagsúla laistigh den chuntas 

ainmniúil. Éascóidh sé seo tuarascáil ghníomhaíochtaí ainmniúla a reáchtáil 

de réir roinne do chód 2105 amhail ag an 31.08.2023 chun críocha 

iniúchóireachta.  

 

17. Mar mhalairt ar sin, déan liosta de láimh d’ioncam/dheontais a fuair an scoil 

le linn a bliana 2022/2023 a bhaineann le scoilbhliain 2023/2024 m.sh. 

deontas leabhar, táillí idirbhliana, táillí riaracháin na scoile, ranníocaíocht 

dheonach.  

 

18. Déan an t-ioncam don bhliain a athbhreithniú lena chinntiú gur cuimsíodh na 

deontais uile a fuarthas don chéad scoilbhliain eile sna cuntais mar 

‘Dheontais Faighte Roimh Ré’ (cóid ainmniúla 2150-2152).  

 

19. Déan an t-ioncam agus caiteachas a athbhreithniú maidir le haon 

deontais/ioncam imfhálaithe agus tabhair ar aghaidh aon mhéideanna nach 

bhfuil caite mar dheontais/ioncam gan chaitheamh. Féach Aguisín 2 chun 

tuilleadh faisnéise a fháil. 

 

20. Cinntigh go bhfuil na hiarmhéideanna maidir le deontais COVID gan 

chaitheamh, cuimsithe mar is ceart sna cuntais. Féach Aguisín 1 chun tuilleadh 

faisnéise a fháil. 

 

21. Cruthaigh Tuarascáil ar Ghníomhaíochtaí Ainmniúla agus seiceáil ar 

breacadh síos na hidirbhearta go cruinn lena chinntiú gur tugadh cuntas ceart 

orthu. 

 

22. Ba cheart Coigeartuithe Deireadh Bliana maidir le creidiúnaithe, 

féichiúnaithe agus ioncam faighte roimhe ré a bhreacadh in SAGE 50 ar an 

31.08.2023  más féidir sula ligtear dóibh leanúint ar aghaidh go deireadh 

na bliana. 
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E. Priontáil amach na Tuarascálacha Airgeadais atá molta le haghaidh dheireadh 
na bliana. 

Tuarascálacha Chun Tuarascálacha a Rith 

Comhardú Trialach Nominal codes > Trial Balance 
Nominal codes > Reports > Trial Balance 
 

Clár Comhardaithe Nominal codes > Reports > My nominal code reports >BOM Balance 
Sheet 
 

Brabús agus 
Caillteanas 

Nominal codes > Reports > My nominal code reports >BOM Income & 
Expenditure Account 
 

Gníomhaíocht 
Ainmniúil  

 
Nominal codes > Reports> Nominal Activity 
 

Íocaíochtaí / Fáltais 
Neamhréitithe 

 
Bank accounts > Reports > Unreconciled transactions 
 

Tuarascáil ar 
chreidiúnaithe 
aosaithe 
(le haghaidh 
scoileanna a 
úsáideann modúl an 
tSoláthraí amháin) 

 
Suppliers > Reports > Aged creditors > Aged creditors summary  
Suppliers > Reports > Aged creditors > Aged creditors detailed 
Suppliers > Reports > Activity > supplier activity detailed 

Tuarascáil ar 
fhéichiúnaithe 
aosaithe 
(le haghaidh 
scoileanna a 
úsáideann modúl an 
Chustaiméara amháin) 
 

 
Customers > Reports > Aged debtors > Aged debtors analysis summary  
Customers > Reports > Aged debtors > Aged debtors analysis detailed 
Customers > Reports > Activity>customer activity detailed 
 

 
Tuarascáil roinne  
do chód 2105 

 
Department > Reports > Nominal Analysis > Nominal Department 
analysis detailed > cód ainmniúil 2105 agus an réamhshocrú ar na 
huimhreacha roinne 
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Tuarascáil roinne  
Le haghaidh 
idirbhearta COVID 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Departments > Reports > Nominal Analysis > Nominal Department 
analysis detailed > baineann roinn 1 le COVID sa sampla seo. Lig mé 
don cód ainmniúil a bheith réamhshocraithe ionas go dtabharfaidh sé 
gach cód ina sanntar roinn 1. 

 
 
 
 
 
 
 
 
 
 
 
 

NB: Mura sannadh uimhir na rannóige ábhartha d’idirbhearta COVID ní 
bheidh siad le feiceáil sa tuarascáil seo.  
 

 

 

F. Cóip Chúltaca den Chóras 

 
Déan DHÁ Chóip chúltaca ar a laghad agus déan iad a shábháil in dhá shuíomh ar 
leith (Líonra/tiomántán crua seachtrach). Tabhair ‘Roimh Dheireadh na Bliana’ mar ainm 
orthu - tá sé ríthábhachtach cóip chúltaca a dhéanamh de na sonraí sula ndéanfar 
deireadh na bliana a rith, toisc gurb é sin an t-aon slí chun dul ar ais go dtí staid 
réamhbhliana.  

 
Féach ar Chuid G maidir le deireadh do bhliana a rith i Sage 50. Déan teagmháil le 
FSSU le tuilleadh eolais nó soiléiriú a fháil ar aon cheann de na saincheisteanna sa 
Treoirlíne seo.  

 

G.  Deireadh Bliana a Phróiseáil in Sage 50 

 

Ba cheart do scoileanna idirchaidreamh a dhéanamh lena gcuntasóirí/lena n-iniúchóirí 

seachtracha agus a iarraidh orthu a gcuid cuntas a athbhreithniú chomh luath agus is 

féidir agus Dréacht-chomhardú Trialach a chur isteach, ina n-áireofar athruithe ar na 

cuntais ioncaim agus caiteachais don bhliain. Féadfar na coigeartuithe iniúchta a bhfuil 

gá leo a chur isteach i Sage 50 sula ndéanfar deireadh na bliana a phróiseáil agus 

beidh na figiúir le haghaidh Ioncaim agus Caiteachais a bheidh le feiceáil sna cuntais 

arna gcur i gcartlann i gcomhréir, tríd is tríd, leis na Ráitis Airgeadais sínithe amhail ar 

an 31.8.2023. Má bhíonn tuilleadh athruithe i gceist tar éis próiseáil dheireadh na 

bliana, féadfar na coigeartuithe a dhéanamh ar chóid an Chláir Chomhordaithe dar 

dáta an 31.08.2023. 

Tá deireadh bliana bog ag Sage 50, rud a chiallaíonn gur féidir leat breacadh i do 
bhliain airgeadais nua sula ritheann tú an rogha Deireadh Bliana. Tá sé tábhachtach 
deimhin a dhéanamh go bhfuil dáta an idirbhirt i gceart. Beidh teachtaireacht le feiceáil 
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ina gcuirfear in iúl go bhfuil an dáta lasmuigh den bhliain airgeadais reatha, cliceáil ar 
Ok nó Tá. Féadfar na tuarascálacha seo a leanas a rith i leith na bliana airgeadais nua 
go dtí go ritheann tú deireadh na bliana - Brabús agus Caillteanas ó Idirbhearta, Cláir 
chomhardaithe na nIdirbheart agus tuarascálacha ar Chomharduithe Trialacha na 
nIdirbheart. Tabhair faoi deara le do thoil go bhfuil na tuarascálacha sin beartaithe le 
haghaidh úsáid inmheánach/oifige agus nár cheart iad a úsáid le haghaidh chruinnithe 
an Bhoird Bhainistíochta.  

Chun tuarascálacha an Bhoird Bhainistíochta a rith i gcomhair na bliana nua, lena n-áirítear 
an buiséad le haghaidh 2023/2024 agus figiúir na bliana roimhe sin, ní mór Deireadh na 
Bliana Airgeadais a rith i Sage 50. Dá bhrí sin, ní féidir an próiseas deireadh bliana seo 
a chur siar rófhada sa Bhliain Airgeadais nua ar mhaithe le coigeartuithe iniúchta. 
Molaimid gurb é an dáta is déanaí chun Deireadh na Bliana a reáchtáil i Sage an chéad 
tseachtain i mí na Samhna 2023 chun a chinntiú go bhfaighidh an Bord Bainistíochta na 
tuairiscí cinntitheacha go léir don bhliain airgeadais nua. 

I gcás go bhfuil Sage suiteáilte ar líonra, ba chóir an gnáthamh deireadh bliana a rith 
ar an ríomhaire ar a bhfuil na sonraí. Má tá tacar mór sonraí agat, féadfaidh roinnt ama 
a bheith i gceist leis an bpróiseas a rith. Laghdófar an tréimhse ama sin má ritheann tú 
an gnáthamh ar an ríomhaire ar a gcoinnítear sonraí do chuntas. 

 

6. Deireadh na Bliana Airgeadais a Rith 

• Athraigh dáta an chláir-athraigh dáta an chláir go dtí an lá deireanach den 
bhliain airgeadais, m.sh. 31ú Lúnasa 2023. 

• Déan DHÁ chóip chúltaca agus cuir an lipéad ‘Before Year End’ orthu - tá sé 
ríthábhachtach cóip chúltaca a dhéanamh de na sonraí sula ndéanfar deireadh 
na bliana a rith, toisc gurb é sin an t-aon slí chun dul ar ais go dtí staid 
réamhbhliana. Moltar dhá chóip chúltaca a dhéanamh mar réamhchúram ar eagla 
go ndéanfaí damáiste do na meáin chúltaca nó go gcaillfí ceann díobh. 

• Chun Deireadh Bliana a rith, roghnaigh Tools >Period End >Year End.  

• Ansin taispeánfar an fhuinneog deireadh bliana agus cuirfear na céimeanna go 

léir i gcrích. 

• Archive Data - roghnaigh an rogha seo chun sonraí a chur i gcartlann. Ar an 
mbealach sin beidh tú in ann féachaint ar sheansonraí gan seanchóipeanna cúltaca 
a thabhairt ar ais.  

• Cuir cosc ar idirbhearta nua a chur isteach roimh an dáta seo – ba chóir duit an 
rogha seo a fhágáil gan tic más rud é nár phostáil tú do choigeartuithe iniúchta 
go fóill. 

• Seiceáil go bhfuil na sonraí a thaispeántar ag bun na fuinneoige Deireadh 
Bliana ceart sula roghnaíonn tú an rogha Rith Deireadh Bliana.  

• Roghnaigh YES má tá na dátaí Deireadh Bliana ceart.  

• Beidh scáileán dul chun cinn deireadh bliana le feiceáil ansin. Nuair a bheidh sé 
curtha i gcrích fiafrófar díot an mian leat iris Deireadh Bliana a phriontáil. 
Cliceáil ar ok. 
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• Beidh teachtaireacht deiridh le feiceáil le deimhniú go bhfuil deireadh an bliana 
airgeadais curtha i gcrích, cliceáil ar OK. 
 

7. Déan na Sonraí a Sheiceáil Tar Éis Deireadh na Bliana a Rith  

Déan comhardú trialach Tugtha Ar Aghaidh a rith. Roghnaigh Modules >Nominal 
codes >Trial Balance i gcomhair na tréimhse roghnaigh Brought Forward 
 

➢ Deimhnigh nach bhfuil aon chóid ioncaim agus caiteachais ar an tuarascáil sin 

➢ Ansin, déan do shonraí a sheiceáil arís. File>Maintenance > check Data 

➢ Ar deireadh, déan cóip chúltaca eile de na sonraí agus cuir ‘After Year End’ 

mar lipéad uirthi. 

➢ NÁ déan an rian iniúchta a ghlanadh. Má tá sonraí cuntasaíochta le 
haghaidh níos mó ná dhá bhliain ar Sage 50 áfach, agus gur cosúil go bhfuil 
próiseáil Sage moill mar thoradh ansin ba cheart smaoineamh ar an rian 
iniúchta a ghlanadh. Féach an rannán Sage 50 den láithreán gréasáin le 
haghaidh sonraí maidir leis an bpróiseas sin. 
 

Tá sonraí iomlána maidir le deireadh bliana a rith le fáil sa:  
 ‘Lámhleabhar FSSU ar Chuntais SAGE - Cuid 8’  

8. Ba cheart Buiséad na Scoile le haghaidh 2023/2024 a iompórtáil anois chuig Sage 
50.   

Tá bileog excel nua san áireamh sa Teimpléad Buiséid 2023/2024 ar a dtugtar 
"Sage 50 Import" ina dtugtar achoimre ar na cóid ainmniúla agus na figiúirí buiséid 
iomlána don bhliain. Is féidir na sonraí i gColún A, B & D den bhileog seo a chóipeáil 
isteach i dteimpléad atá ar fáil i Sage 50, agus cuirfidh sé seo ar chumas na sonraí 
buiséid a iompórtáil isteach i Sage 50.  

Féach ar ár suíomh gréasáin anseo chun treoir a fháil mar aon le físeán taispeána 
ar an bpróiseas. Déan deimhin de go bhfuil na cóid ainmniúla céanna ag do 
theimpléad iompórtála buiséid agus atá i do chuntais Sage 50 agus go ndéanfar 
cóip chúltaca sula ndéantar an fhaisnéis a iompórtáil.  

9. Coigeartuithe iniúchta 

Nuair atá deireadh na bliana rite, ba cheart an dáta 31.08.2023 a chur le haon 
choigeartuithe iniúchta ar Chuntais 2022/2023 agus ní ceart iad a dhéanamh ach i 
leith cóid an Chláir Chomhardaithe agus ba cheart coigeartuithe Ioncaim agus 
Caiteachais a bhreacadh i gcód Cúlchistí Ioncaim 2710, Barrachas Tugtha Ar Aghaidh. 

10. Comparáidí na bliana roimhe sin 

Do na scoileanna sin ar mian leo go mbeadh comparáidí idir an bhliain roimhe agus 
an bhliain reatha go dtí seo le feiceáil ina gCuntas Ioncaim agus Caiteachais in ionad 

https://www.fssu.ie/app/uploads/2017/07/FSSU-SAGE-Accounts-Manual.pdf
https://www.fssu.ie/post-primary/topics/sage-50-accounts/training/training-videos/importing-the-budget/
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na bliana roimhe ina hiomláine, tá an tuarascáil roghnach sin mar aon le treoracha 
maidir lena gcóipeáil isteach i Sage 50 le fáil sa chuid Ag tosú le Sage 50 Cloud dár 
láithreán gréasáin. 

H. Oiliúint maidir le Sage 50 

Tá roinnt seimineár gréasáin oiliúna beo á reáchtáil againn ó Mheán Fómhair go Samhain 
chun an Treoirlíne seo a fhorlíonadh agus a thacú trí threoir a chur ar fáil maidir leis an 
gcuntas deireadh bliana a réiteach agus a thabhairt chun críche in Sage 50. 

Tá dhá sheimineár gréasáin beartaithe do phearsanta nua Cuntas, an chéad cheann acu 
dóibh siúd atá ag tabhairt na cuntais deireadh bliana do mhí Lúnasa suas chun dáta den 
chéad uair, agus ceann eile a dhíreoidh ar an gcairt chuntas & tuairisciú ó Sage 50 a 
mhíniú. 

Tá seimineár gréasáin oiliúna beartaithe chun an modúl Soláthraithe in Sage 50 a úsáid 
d’fhonn scoileanna a spreagadh le haistriú i dtreo an mhórleabhair Soláthraithe a úsáid 
chun sonraisc cheannacháin a thaifeadadh in Sage 50.  

Cuirfidh na seimineáir ghréasáin seo uile leis an soláthar físeán éilimh FSSU do Sage 50 
atá ar fáil ar ár suíomh idirlín. Chomh maith leis na físeáin Sage, tá rannán nua ar ár 
suíomh idirlín  a bhfuil áiseanna éagsúla d’fhíseáin oiliúna ann do phearsanra nua cuntas, 
rud a fheabhsóidh a saineolas ar chuntais scoile a ullmhú. 

Leanfaidh an FSSU le tacaíocht agus oiliúint leanúnach a chur ar fáil le cinntiú go n-
úsáideann scoileanna an bogearra chomh maith agus is féidir leanfaidh le cúnamh a 
thabhairt do scoileanna leis na gnéithe nua in Sage 50 Cloud Accounts. Molaimid, go 
háirithe, úsáid a bhaint as fothaí bainc mar gheall go bhfeabhsóidh sé seo éifeachtúlacht 
agus tráthúlacht na feidhme cuntas, agus ligeann an chianrochtain ar shonraí d’úsáideoirí 
ceadaithe ó lucht bainistíochta na scoile rochtain fíorama a bheith acu ar shonraí 
airgeadais na scoile.  

 

Guthán: 01-269 0677  

info@fssu.ie  

 

An 12 Meán Fómhair 2023 

 
 

 

 

 

 

https://www.fssu.ie/post-primary/training/training-resources-for-new-accounts-personnel/
https://www.fssu.ie/post-primary/training/training-resources-for-new-accounts-personnel/
mailto:info@fssu.ie
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Aguisín 1 
 

Cur Chuige Cuntasaíochta maidir le Deontais COVID gan 
Chaitheamh  

 
Ní mór cuntas a thabhairt ar an gcuid sin den Deontas Caipitíochta Glantacháin agus 
Trealaimh Cosanta Phearsanta COVID nár caitheadh ag deireadh na bliana faoin 
gCód 2186 i gcairt na gcuntas.  
 
Lean na céimeanna thíos chun cuntas a thabhairt ar na deontais nár caitheadh: 
 

▪ Céim 1: Ríomh méid an deontais nár caitheadh amhail ar an 31.08.2023  
(Ioncam Lúide Caiteachas) 
 

▪ Céim 2: Déan iontráil dar dáta 31.08.2023 chun an t-airgead nár caitheadh a 
aistriú chuig an gclár comhardaithe.  
 

▪ Tabhair do d'aire: Ós rud é go bhfuil an chuid neamhchaite den deontas COVID 
amhail ar an 31.08.2023 le cur ar ais chuig an Roinn faoin 30.09.2023, ní gá na 
deontais a chur ar ais sa chód Ioncaim agus Caiteachais ar an 01.09.2023 
 

Cliceáil anseo le haghaidh bileog oibre chun cabhrú le cuntas a thabhairt ar dheontais 
COVID neamhchaite. 
 
 

 

 

 

 
 
 
 
 

Deontas 
 

 

 
 

 Céim 1 Céim 2 

Ioncam 
 

Caiteachas 
 

Iarmhéid an 
Deontais 
amhail ar 

an 
31.08.2023 

 

Déan iontráil maidir leis an méid 
gan chaitheamh ar an 

31.08.2023 

Cód 
Ainmniúil 

Suim Cód 
Ainmniúil 

Suim Suim Cód 
Dochair 

 

Cód 
Creidmheasa  

Rannóg 

 
Deontas 
Caipitíochta 
COVID le 
haghaidh 
 PPE 

 
3288 

 
€29,000 

 
5806 

 
€18,000 

 
€11,000 

 
3288 

 
2186 

 
COVID 

https://www.fssu.ie/app/uploads/2023/09/Covid-Grant-Reconciliation-Template-for-the-period-ending-Aug-2023_rev.xlsx
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Aguisín 2 

Cur Chuige Cuntasaíochta maidir le Deontais/Ioncam gan 
Chaitheamh 

 
Faightear roinnt deontas/ioncam chun críche ar leith, mar shampla an deontas TFC agus 
an deontas maoirseachta agus ionadaíochta. Tugtar deontais imfhálaithe orthu sin. Ba 
cheart an sciar de na deontais sin nach bhfuil caite a chur siar go dtí go gcaithfear é sa 
scoil. 
 
Ní mór cuntas a thabhairt ar an gcuid sin d’iarmhéideanna deontas imfhálaithe nár 
caitheadh ag deireadh na bliana faoin gcód/faoi na cóid ábhartha (2160-2180) ar an 
gclár comhardaithe sa chairt chuntas.  
 
Is samplaí de dheontais imfhálaithe iad na deontais seo a leanas. 
 

➢ Deontas Leabhar, Deontas um Maoirseacht agus Ionadaíocht, Deontas TFC, 
Deontas Pá Neamh-mhúinteora, Deontas um Thionlacaithe Bus, Deontas Béilí 
Scoileanna srl. 
 

Lean na céimeanna thíos chun cuntas a thabhairt ar na deontais nár caitheadh: 
 

▪ Céim 1: Ríomh méid an deontais nár caitheadh amhail ar an 31.08.2023 
(Ioncam Lúide Caiteachas) 
 

▪ Céim 2: Déan iontráil dar dáta 31.08.2023 chun an t-airgead nár caitheadh a 
aistriú chuig an gclár comhardaithe.  
 

▪ Céim 3: Déan iontráil dar dáta an 01.09.2023 chun an ghné neamhchaite a aistriú 
ar ais chuig an tuarascáil Ioncaim agus Caiteachais le húsáid sa bhliain dar thús an 
31.08.2024. 
 

Cliceáil anseo le haghaidh bileog oibre chun cabhrú le cuntas a thabhairt ar deontais 
neamhchaite. 

 

  

https://www.fssu.ie/app/uploads/2023/09/VSS-calculation-of-unspent-grants-template.xlsx
https://www.fssu.ie/app/uploads/2023/09/VSS-calculation-of-unspent-grants-template.xlsx
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Tábla2: Sampla de Chuntas a Thabhairt ar dheontas nár caitheadh 

 
 

 

 

 
 
 
 
 

Deontas 

Céim 1 Céim 1 Céim 1 Céim 2 Céim 3 

Ioncam 
 

Caiteachas 
 

Iarmhéid an 
Deontais 
amhail ar 

an 
31.08.2023 

 

Déan iontráil 
maidir leis an 

méid gan 
chaitheamh ar 
an 31.08.2023 

 

Déan iontráil 
maidir leis an méid 

gan chaitheamh 
ar an 01.09.2023 

 

Cód 
Ainmni
úil 

Suim Cód 
Ainmn
iúil 

Suim Suim Cód 
Dochair 
 

Cód 
Creid
mheas
a  

Cód 
Dochair 

Cód 
Creidmh
easa  

Deontas Leabhar 3150 €9,600 4730 €8,900 €700 3150 2160 2160 3150 

Deontas le haghaidh 
Maoirseacht agus 
Ionadaíocht 

3240 €5,130 4150 €4,200 €930 3240 2170 2170 3240 

Deontas Caipitil faoi 
chomhair Leabhair 
don Leabharlann 
Scoile 

3155 €15,000 4641 €1,000 €14,000 3155 2161 2161 3155 

Deontas le haghaidh 
Tionlacaithe Bus 

3294  4196   3294 2171 2171 3294 

DSP Béilí Scoile 3296  4912   3296 2171 2171 3296 

Straitéis 
Dhigiteach/Deontas 
TFC 
(Neamhchaipiteal) 

3230  €27,500 

 
 

 

4410  €17,500 €10,000 3230  2165 2165 3230 

Straitéis 
Dhigiteach/Deontas 
TFC 
(Neamhchaipiteal) 

3921 €27,500 1461 €17,500 €10,000 3921 2165 2165 3921 

Deontas Roinnte 
Digiteach 
(Neamhchaipiteal) 

3230  €20,000 4410  €17,500 €2,500 3230  2179 2179 3230 

Deontas Roinnte 
Digiteach 
(Caipiteal) 

3921 €20,000 1461 €17,500 €2,500 3921 2179 2179 3921 


